


CHAPTER 01  ഡിസൈ�നിങിന്റെ� ല�ോകല�ക്ക് 

1) ഇങ്ക്സ്കേ�പ്പില്‍ തയാറാക്കിയ  സ്കേ�ാസ്റ്ററിസ്കേ�ക്ക് ഒരുചിത്രം ഉള്‍പ്പെപ്പടുത്തണം.  വലുതാക്കിയാല്‍ വ്യക്തത കുറയാത്ത 
ചിത്രം ആയിരിക്കണം. ചുവപ്പെ( നല്‍കിയിരിക്കുന്നതില്‍ എത് ചിത്രമാണ് അനുസ്കേയാജ്യം?  

a) image.jpg b )image.svg c)image.png  d ) image.bmp

2) ഇങ്ക്സ്കേ�പ്പ് ക്യാന്‍വാസില്‍ ഉള്‍പ്പെപ്പടുത്തിയ രണ്ട് ഒബ് ജക്ടുകളില്‍ �ിറകിലുള്ള ഒബ്  ജക്ടിപ്പെന മുന്‍�ില്‍ 
എത്തിക്കുന്നതിന് സഹായിക്കുന്ന സസ്കേങ്കതം ഏത്?

A)   Raise B) Below C) Up  D) Down 

3) ഇങ്ക്സ്കേ�പ്പ് ക്യാന്‍വാസില്‍ ഉള്‍പ്പെപ്പടുത്തിയ ഒരു ഒബ് ജക്ടിന് നല്‍കിയിരിക്കുന്ന നിറത്തിപ്പെV കടുപ്പത്തിന് 
വ്യത്യാസം വരുത്തണം. ഇതിന്  ഉ�സ്കേയാഗിക്കാവുന്ന  സസ്കേങ്കതം  ഏത്?

A  Flat color B Opacity  C Path D Offset

4) ഇങ്ക്സ്കേ�പ്പ്  സ്കേസാഫ്റ്റ് പ്പെവയറില്‍   Fill and Stroke ജാ�കത്തിപ്പെ� Stroke paint (ാബ് ഉ�സ്കേയാഗിച്ച് താപ്പെf 
�റയുന്നവയില്‍ എത് പ്രവര്‍ത്തനമാണ് പ്പെചയ്യാന്‍ സാധിക്കുക?

A  ഒബ് ജക്ടിന് നിറം നല്‍കാം

B ഒബ് ജക്ടിപ്പെV നിറം ഒfിവാക്കാം

C ഒബ് ജക്ടിപ്പെV �രിധിക്ക് നിറം നല്‍കാം

D ഒബ് ജക്ടിപ്പെV സ്റ്റൈസ്റ്റല്‍ മാറ്റാം

5) താപ്പെf �റയുന്നവയില്‍ പ്പെവക്ടര്‍ ഇസ്കേമജ് ഫയല്‍ എതാണ് ?

A.  Circle.png B. Circle.jpg C. Circle.svg D. Circle.gif

6)  ഇങ്ക്സ്കേ��ില്‍ തയാറാക്കുന്ന ഒരു സ്കേ�ാസ്റ്ററിസ്കേ�ക്ക്  അനു image.png എന്ന ചിത്രപ്പെത്ത ഉള്‍പ്പെപ്പടുത്തി വലുതാക്കി. 
ആ ചിത്രപ്പെത്ത സംബന്ധിച്ച് ചുവപ്പെ( നല്‍കിയിരിക്കുന്ന പ്രസ്താവനകളില്‍ ശരിയായത് ഏത്?

A വലുപ്പം കൂടുസ്കേuാറും വ്യക്തതക്ക് 
മാറ്റം വരുന്നില്ല.

B വലുപ്പം കൂടുസ്കേuാറും വ്യക്തത കുറയുന്നു. 

C വലുപ്പം കൂടുസ്കേuാറും വ്യക്തത കൂടുന്നു. 



D മുകളില്‍ നല്‍കിയ മൂന്നു പ്രസ്താവനകളും
 പ്പെതറ്റാണ്.            

7) ഇങ്ക്സ്കേ�പ്പില്‍ ഒന്നില്‍ കൂടുതല്‍ ചിത്രങ്ങപ്പെള സ്കേചര്‍ത്ത് ഒരു യൂണിറ്റാക്കി മാറ്റാന്‍ ചുവപ്പെ( നല്‍കിയതില്‍ ഏതു 
സസ്കേങ്കതമാണ് അനുസ്കേയാജ്യം?

A Clip  B Mask C       Transform D Group

8) ഇങ്ക്സ്കേ�പ്പില്‍ വരച്ച  ചിത്രപ്പെത്ത ക്യാന്‍വാസ് സ്റ്റൈസസില്‍ തപ്പെന്ന  എക്സ്സ്കേ�ാര്‍ട്ട് പ്പെചയ്യുന്നതിന് എക്സ്സ്കേ�ാര്‍ട്ട് 
ജാ�കത്തില്‍ പ്പെസ�ക് (് പ്പെചസ്കേയ്യണ്ട അനുസ്കേയാജ്യമായ ഓ�്ഷന്‍ ഏത് ?

A  Page  B Drawing C Selection D Custom

10) ഇങ്ക്സ്കേ�പ്പില്‍ തയാറാക്കിയ ചിത്രത്തില്‍ ഒരു പ്പെ(ക് സ്റ്റ് കമാനാകൃതിയില്‍ ഉള്‍പ്പെപ്പടുത്തണം. അതിനായി 
പ്പെ(ക് സ്റ്റും അര്‍ദ്ധവൃത്താകൃതിയുള്ള ഒബ് ജക്ടും തയ്യാറാക്കി. ചുവപ്പെ( നല്‍കിയതില്‍ ഏതു ഒ�്ഷനാണ് 
ഇതിനായി ഉ�സ്കേയാഗിസ്കേക്കണ്ടത് ?

A Text → Text and Font. 

B Text → Put on Path 

C Text → Remove from Path

D Text → Convert to Text.

10) ഇങ്ക്സ്കേ��് സ്കേസാഫ്റ്റ് പ്പെവയറിപ്പെV ടൂള്‍ സ്കേബാക്സില്‍ കാണുന്ന ഒരു ടൂളാണ്  ചിത്രത്തില്‍.  ഇതിപ്പെV ഉ�സ്കേയാഗപ്പെമu്  ?

A. ചതുരം വരക്കാന്‍

B. വൃത്തം വരക്കാന്‍

C. സ്കേനാഡ് എഡിറ്റ് പ്പെചയ്യാന്‍

D. അക്ഷരങ്ങള്‍ ഉള്‍പ്പെപ്പടുത്താന്‍

11) ഇങ്ക്സ്കേ��ില്‍ തയാറാക്കിയ ഒരു വൃത്തപ്പെത്ത  നിfലും പ്പെവളിച്ചവും കാണിക്കുന്ന രീതിയില്‍ നിറം നല്‍കി ഒരു 
സ്കേഗാളമാപ്പെണന്ന പ്രതീതി ജനിപ്പിക്കാന്‍ സഹായിക്കുന്ന  സസ്കേങ്കതം ഏത് ?

A.  Blur B. Fill C. Opacity D. Gradient

12) 

ഇങ്ക്സ്കേ��ില്‍ ഒരു ചായക്കപ്പ് വരക്കുന്നതിപ്പെV 3 ഘട്ടങ്ങളാണ് മുകളിലുള്ളത്. ഇതില്‍ മൂന്നാമപ്പെത്ത രൂ�ം നിര്‍



മ്മിക്കാനായി രണ്ടാമപ്പെത്ത രൂ�ത്തില്‍ പ്പെചയ്ത പ്രവര്‍ത്തനസ്കേമത് ?

A. Object ⟶ Group

B. Fill and Stroke ⟶ Opacity

C. Path   ⟶     Difference  

D. Edit ⟶Duplicate

13) ഇങ്ക്സ്കേ��ില്‍ വരച്ച രണ്ട് ചിത്രങ്ങളാണ് മുകളിലുള്ളത്. ഇതില്‍ ആദ്യ ചിത്രത്തിന് മാറ്റം വരുത്തി  
രണ്ടാമസ്കേത്തതു സ്കേ�ാപ്പെ�യാക്കണം. ചുവപ്പെ( നല്‍കിയതില്‍ ഏതു സസ്കേങ്കതമാണ് ഇതിന് അനുസ്കേയാജ്യം?

A. Object  ⟶ Group

B. Fill and Stroke  ⟶  Blur  

C. Path ⟶Difference

D. Edit ⟶Duplicate

14) ചിത്രഫയലുകപ്പെള സംബന്ധിച്ച് ചുവപ്പെ( പ്പെകാടുത്തിരിക്കുന്നവയില്‍ ശരിയായ പ്രസ്താവന ഏത്?

A svg   ചിത്രങ്ങള്‍ പ്പെവക് (ര്‍ ചിത്രങ്ങളാണ്  .   

B പ്പെവക്ടര്‍ ചിത്രങ്ങള്‍ പ്പെ�യില്‍ പ്പെചയ്യുസ്കേ�ാള്‍ 
വ്യക്തത നഷ്ടപ്പെപ്പടുന്നു.

C ബിറ്റ് മാപ്പ് ചിത്രങ്ങപ്പെള പ്പെവക് (ര്‍ ചിത്രങ്ങള്‍ 
എന്നും �റയാം.

D svg ചിത്രങ്ങള്‍ റാസ്റ്റര്‍ ചിത്രങ്ങളാണ്. 

15)  ഇങ്ക്സ്കേ�പ്പ് സ്കേസാഫ്റ്റ് പ്പെവയറില്‍ കളര്‍ �ാ�റ്റ് ഉ�സ്കേയാഗിച്ച് ഒരു ഒബ് പ്പെജക്ടിപ്പെV Stroke ന് നിറം നല്‍കാനായി 
മൗസ് ക്ലിക്കിപ്പെനാപ്പം ഉ�സ്കേയാഗിക്കുന്ന കീ എതാണ് ?

A  Shift B Space C Tab D F1

16) ചിത്രസ്കേഫാര്‍മാറ്റുകളുമായി ബന്ധപ്പെപ്പട്ട്  SVG എന്നതിപ്പെV പൂര്‍ണരൂ�ം എu് ?

A  Stable Vector Graphics

B Scalable Virtual Graphics

C Steady Vector Graphics

D Scalable Vector Graphics

17)  ചുവപ്പെ( സ്കേചര്‍ത്തിരിക്കുന്നവയില്‍നിന്നും പ്പെവക്ടര്‍ ഇസ്കേമജ് എഡിറ്റിങ്ങ് സ്കേസാഫ്റ്റ് പ്പെവയര്‍ കപ്പെണ്ടത്തുക.



A GIMP

B   Tux paint

C  Xpaint

D  Inkscape

18) ഒരു ചായക്കപ്പിപ്പെV ചിത്രം വരക്കുവാനായി ഇങ്ക്സ്കേ�പ്പ് കാന്‍വാസില്‍
�ംബമായ ഒരു ദീര്‍ഘവൃത്തവും അതിനു മുകളില്‍ മപ്പെറ്റാരു വൃത്തവും വരച്ചു. 

ഇവയില്‍ വൃത്തഭാഗത്തിപ്പെന ഒfിവാക്കി, ദീര്‍ഘവൃത്തത്തിപ്പെന ഒരു കപ്പിപ്പെV
രൂ�ത്തി�ാക്കണം. ചുവപ്പെ( നല്‍കിയിരിക്കുന്ന ഏത്  സസ്കേങ്കതത്തിലൂപ്പെ( ഇതു
സാധ്യമാവും?

A Path   →     Difference  

B   Path → Union

C  Path → Raise

D  Path → Group

19) ഇങ്ക്സ്കേ��ില്‍ തയാറാക്കിയ ഒരു ചിത്രം png സ്കേഫാര്‍മാറ്റിസ്കേ�ക്ക്  സ്കേസവ് പ്പെചയ്യുന്നതിനുള്ള പ്രവര്‍ത്തനക്രമം ചുവപ്പെ(
നല്‍കിയവയില്‍ നിന്ന് തിരപ്പെªടുക്കുക.

A. File → Save As

B. File   →        Export PNG Image  

C. File → Import Clip Art

D. File → Save a Copy

20) ചുവപ്പെ( നല്‍കിയിരിക്കുന്നവയില്‍ സ്വതന്ത്ര പ്പെവക്ടര്‍ ഇസ്കേമജ് എഡിറ്റിങ്ങ് സ്കേസാഫ്റ്റ് പ്പെവയര്‍ ഏത് ?

A. �ിബര്‍ഓഫീസ് സ്കേ®ാ

B. അസ്കേഡാബ് ഇല്ലസ്കേ¯റ്റര്‍

C. സ്കേകാറല്‍ സ്കേ®ാ

D. ജി�്



STANDARD 10 – UNIT 2:പ്രസിദ്ധീകരണത്തിലേ�ക്ക്

QUESTIONS AND ANSWERS

1. ഒരു ടെ�ക ്സ്റ്റ് ഡ
ോക്യുടെ
ന്റിടെന്റ ഡ�ജും ഉള്ള�ക്കവും 
ഡ�ോഹര
ോയി ക്ര
ീകരിച്ച്, 

പ്രിന്റ്  ടെ�യ്യുന്നതി�ോയി  തയ്യോറോക്കുന്ന പ്രവര്‍ത്ത�ടെത്ത ടെ�ോതുടെവ എന്ത്  

ഡ�രിലോണ് വിളിക്കുന്നത് ?

➢ ഡസ്‍ക‍്ലേ�ോപ്പ്‍പബ്ലിഷിങ്

➢ കമ്പ്യൂട്ടര്‍ പ്രിന്റിങ്

➢ ഡലസര്‍ പ്രിന്റിങ് ടെ�ക ്ഡ�ോളജി

➢ 
ോര്‍ക്ക് അ�് സോഡ6തിക വിദ്യ

2. ലിബര്‍ഓഫീസ് റൈററ്റര്‍ ഡസോഫ്റ്റ് ടെവയറില്‍ തയ്യോറോക്കുന്ന ഒരു ഡ
ോക്യുടെ
ന്റില്‍ 

ഉള്ള�ക്കപ്പട്ടിക ഉള്‍ടെപ്പടുത്തുന്നതി�ോയി �ില �ദങ്ങടെള ശീര്‍ഷകങ്ങളോയി 

�ിര്‍വ�ിക്കണം. ഇതിനു ഉ�ഡയോഗിക്കോവുന്ന സഡ6തം ഏതോണ് ?

➢ Style

➢ Clone

➢  Filter

➢ Mail Merge

3. ഒരു ഡ
ോക്യുടെ
ന്റിടെല �ില ഭോഗങ്ങള്‍ക്ക് �ല്കിയിട്ടുള്ള ഡഫോര്‍
ോറ്റുകള്‍ 

അഡത��ി 
റ്റു സ
ോ� ഭോഗങ്ങളില്‍ �കര്‍ത്തോന്‍ (ലിബര്‍ഓഫീസ് 

റൈററ്ററില്‍) ഉ�ഡയോഗിക്കോവുന്ന സഡ6തം തോടെR �റയുന്നവയില്‍ ഏതോണ് ?

➢ ടെ
യില്‍ ടെ
ര്‍ജ്

➢ 
സ ്ക ്ഡ�ോപ്പ് �ബ്ലിഷിങ്

➢ ഇന്‍
ക്സ്  ഡഫോര്‍
ോറ്റിങ്

➢ ലേ�ോണ്‍‍ലേ�ോര്‍മോറ്റിങ്
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4. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒഡന്നോ രഡVോ ഡ�ജുള്ള 

ഡ
ോക്യുടെ
ന്റില്‍ ഒരു ശീര്‍ഷകത്തി�്  �ല്‍കിയ ഡഫോര്‍
ോറ്റുകള്‍ 
റ്റ് ശീര്‍

ഷകങ്ങള്‍ക്ക് കൂ�ി �ല്‍കോന്‍ ചുവടെ� ടെകോടുത്തിരിക്കുന്നവയില്‍ ഏതോണ് 

ഉ�ഡയോഗിഡക്കVത്?

➢ Bullets and Numbering

➢ Indexes and Tables

➢ Print

➢ Clone Formatting

5. തോടെR ടെകോടുത്തിട്ടുള്ളവയില്‍  ടെ
യില്‍ടെ
ര്‍ജ് സഡ6തം ഉ�ഡയോഗിച്ചു ടെ�യ്യോന്‍

കRിയുന്ന പ്രവര്‍ത്ത�ം ഏത്?

➢ ഡോറ്റോലേ�സിലുള്ള‍വിവരങ്ങള്‍‍ടെ�ക്‍സ്റ്റ്‍ലേഡോക്യുടെമന്റിലേ�ക്ക്‍ലേ'ര്‍ക്കോന്‍‍

➢ ടെ�ക് സ്റ്റ് ഡ
ോക്യുടെ
ന്റിടെല വിവരങ്ങള്‍ 
ോറ്റോഡബസിഡലക്ക് ഡ�ര്‍ക്കോന്‍

➢ 
ോറ്റോഡബസുകളിടെല വിവരങ്ങള്‍ �രസ്പരം 
ോറ്റോന്‍

➢ റിഡപ്പോര്‍ട്ടിഡലക്ക് ആവശ്യ
ോയ വിവരങ്ങള്‍ 
ോറ്റോഡബസില്‍ തിരയോന്‍

6. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒരു  ഡ
ോക്യുടെ
ന്റില്‍, �ിറത്തിലും 

വലുപ്പത്തിലും രൂ�ത്തിലുടെ
ല്ലോം ഐകരൂ�്യമുള്ള തലടെക്കട്ടുകളും 

ഉള്ള�ക്കവുമുള്ള ഡ�ജുകള്‍ തയ്യോറോക്കുന്നതി�് തോടെR �റയുന്ന ഏടെതല്ലോം 

സഡ6തങ്ങള്‍ ഉ�ഡയോഗിക്കോം ?

➢ Clone Formatting, Style

➢ Index building, Desktop Publishing

➢ Clone Formatting, Mail Merge

➢ Mail Merge, Desktop Publishing

7. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ സ്കൂളിടെ�ക്കുറിച്ച് 50 ഡ�ജുള്ള ഒരു റിഡപ്പോര്‍ട്ട് 

തയ്യോറോക്കി. ഇതിടെല ശീര്‍ഷകങ്ങടെള ഒഡര രീതിയില്‍ ഡഫോര്‍
ോറ്റ് 
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ടെ�യ്യോനും �ല്‍കിയ ഡഫോര്‍
ോറ്റുകള്‍ ഡവഗത്തില്‍ ടെ
ച്ചടെപ്പടുത്തുവോനും 

സഹോയിക്കുന്ന സഡ6തം ഏതോണ്?

➢ Clone Formatting 

➢ Paragraph 

➢ Formatting Style 

➢ Page Formatting

8. ഒരു ഡ�ജിടെന്റ ഉള്ള�ക്കത്തിടെല ഒരു‍പദം‍ശീര്‍ഷകമോയി‍നിര്‍വ'ിക്കോന്‍‍

ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ ലഭ്യ
ോയിട്ടുള്ള‍ഏത് റൈസ്റ്റല്‍ ഉ�ഡയോഗിക്കോം ?

➢ Header 1

➢ Caption 1

➢ Index 1

➢ Heading 1

9. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ �ില ഡ�ജുകളില്‍ 

ഉ�ഡയോഗിച്ചിരിക്കുന്ന  റൈസ്റ്റലുകളില്‍ 
ോറ്റം വരുത്തണം.

ഡ�ജിടെല ഉള്ള�ക്കത്തില്‍ 
ലയോളം 

ഡഫോണ്ടുകളോണ് 

ഉ�ഡയോഗിച്ചിരിക്കുന്നടെത6ില്‍   

�ിത്രത്തില്‍ കോണിച്ചിരിക്കുന്ന ഏതു 

ഭോഗത്തോണ് 
ോറ്റം വരുഡത്തVത് ?

➢ Western Text Font

➢ CTL Font

➢ Font Effects

➢ Lorem Ipsum
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10. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒരു ഡ
ോക്യുടെ
ന്റിടെല                       

ശീര്‍ഷകങ്ങളുഡ�യും ഉ�ശീര്‍ഷകങ്ങളുഡ�യും ഏത് പ്രഡത്യകത തിരിച്ചറിഞ്ഞോണ് 

കമ്പ്യൂട്ടര്‍ അവടെയ ഉള്ള�ക്ക�ട്ടിക (Index Table)യില്‍ ഉള്‍ ടെപ്പടുത്തുന്നത് ?

➢ ശീര്‍ഷകങ്ങളുഡ�യും ഉ�ശീര്‍ഷകങ്ങളുഡ�യും �ിറം (color)

➢ ശീര്‍ഷകങ്ങളുഡ�യും ഉ�ശീര്‍ഷകങ്ങളുഡ�യും വലുപ്പം (size)

➢ ശീര്‍ഷകങ്ങളുലേ�യും‍ഉപശീര്‍ഷകങ്ങളുലേ�യും‍സ്റ്റൈസ്റ്റല്‍‍‍(style)style)

➢ ശീര്‍ഷകങ്ങളുഡ�യും ഉ�ശീര്‍ഷകങ്ങളുഡ�യും ഇന്‍
ന്റ് (indent)

11. ലിബര്‍ഓഫീസ്  റൈററ്ററില്‍  തയോറോക്കിയ  ഒരു ഡ
ോക്യുടെ
ന്റിടെല 

ഉള്ള�ക്കപ്പട്ടികയില്‍�ിന്ന് അവയു
ോയി ബന്ധടെപ്പട്ട  ഡ�ജുകളിഡലക്ക് ഡ�ോകോന്‍

എന്തോണ് ടെ�ഡയ്യVത് ?

➢ Ctrl കീ‍അമര്‍ത്തിപ്പി�ിച്ചുടെകോണ്ട്‍ശീര്‍ഷകം‍�ിക്ക്‍ടെ'യ്യുക.

➢ Alt കീ അ
ര്‍ത്തിപ്പി�ിച്ചുടെകോV് ശീര്‍ഷകം ക്ലിക്ക് ടെ�യ്യുക.

➢ Shift കീ അ
ര്‍ത്തിപ്പി�ിച്ചുടെകോV് ശീര്‍ഷകം ക്ലിക്ക് ടെ�യ്യുക.

➢ Tab കീ അ
ര്‍ത്തിപ്പി�ിച്ചുടെകോV് ശീര്‍ഷകം ക്ലിക്ക് ടെ�യ്യുക.

12. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒരു ഡ
ോക്യടെ
ന്റില്‍ ഉള്ള�ക്ക�ട്ടിക 

ഉള്‍ടെപ്പടുത്തിയഡശഷം  അത് �ി
ിഎഫ് ആയി എക്സ്ഡ�ോര്‍ട്ട് ടെ�യ്തു. ഈ  

ഫയല്‍ തുറന്ന് ഉള്ള�ക്കപ്പട്ടികയില്‍ �ിന്ന് ഒരു പ്രഡത്യക ഉള്ള�ക്കത്തിഡലക്ക്  

ഡ�ോകോന്‍ എന്തോണ് ടെ�ഡയ്യVത്?

➢ ഉള്ള�ക്കപട്ടികയിടെ�‍അതത്‍�ിങ്കില്‍‍�ിക്‍ടെ'യ്തോല്‍‍മതി

➢ ഉള്ള�ക്ക�ട്ടികയിടെല ലി6ില്‍ Alt കീ അ
ര്‍ത്തിപ്പി�ിച്ച് ക്ലിക് ടെ�യ്തോല്‍ 
തി

➢ ഉള്ള�ക്ക�ട്ടികയിടെല ലി6ില്‍ Ctrl കീ അ
ര്‍ത്തിപ്പി�ിച്ച് ക്ലിക് ടെ�യ്തോല്‍ 
തി
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➢ �ി
ിഎഫ്  ആയി എക്സ്ഡ�ോര്‍ട്ട് ടെ�യ്തോല്‍  ഉള്ള�ക്ക �ട്ടിക                      

പ്രവര്‍ത്തിക്കോതോകുന്നു.

13. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയ്യോറോക്കിയിട്ടുള്ള ഒരു ക്ഷണക്കത്തിഡലക്ക്, 

സ്വീകര്‍ത്തോക്കളുടെ� ഡ�രും വിലോസവു
�ങ്ങിയ ഒരു �ട്ടികയിടെല വിവരങ്ങള്‍ 

ഒടെന്നോന്നോയി ഉള്‍ടെപ്പടുത്തോന്‍ പ്രഡയോജ�ടെപ്പടുന്ന സഡ6തം ഏതോണ്?

➢ Formatting

➢ Style

➢ Mail Merge

➢ Index

14. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ, വലിയ ഡ
ോക്യുടെ
ന്റുകളില്‍ 

റൈസ്റ്റലുകള്‍ ഉ�ഡയോഗിക്കുന്നതുടെകോV് ഉVോഡയക്കോവുന്ന �ില 

പ്രഡയോജ�ങ്ങള്‍ തോടെR ഡ�ര്‍ക്കുന്നു. ഇവയില്‍ ടെതറ്റോയത് എത് ?

➢ റൈസ്റ്റലുകള്‍ ഒരിക്കല്‍ ഉ�ഡയോഗിച്ചു കRിഞ്ഞോല്‍ �ിന്നീടുള്ള 
ോറ്റങ്ങള്‍ 

അതതു റൈസ്റ്റലില്‍വരുത്തിയോല്‍ 
തി

➢ റൈസ്റ്റലുകള്‍ ഉ�ഡയോഗിച്ചിട്ടുള്ള എല്ലോയി�ത്തും അതത് 
ോറ്റങ്ങള്‍ 

പ്രതിഫലിക്കും.

➢ വലിയ  പുസ്തകങ്ങഡളോ ഡ
ോക്യുടെ
ന്റുകഡളോ തയ്യോറോക്കുഡമ്പോള്‍ ഇത് ഡജോലി 

എളുപ്പ
ോക്കുന്നു.

➢ ഒലേര‍ലേഡോക്യുടെമന്റില്‍‍തടെ=‍വിവിധ‍ഭോഷകള്‍‍സ്റ്റൈകകോര്യം‍ടെ'യ്യു=ത്‍എളുപ്പമോക്കുന്നു.

15. ലിബര്‍ഓഫീസ് റൈററ്ററിലുള്ള ഒരു ടൂള്‍ ആണ് ചുവടെ�

ടെകോടുത്തിരിക്കുന്നത്. ഇത് എന്ത് ആവശ്യത്തിനുള്ളതോണ് ?

➢ Insert Chart 

➢ Apply Style Box

➢ Add Decimal Place
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➢ Clone Formatting

16. ഒരു സോംസ്കോരിഡകോത്സവത്തിഡലക്ക് �6ോളികടെള ക്ഷണിക്കുന്നതിനുള്ള 

ക്ഷണക്കത്തിടെന്റ 
ോതൃക Invitation.odt എന്ന ഫയലോയും, ക്ഷണിതോക്കളുടെ� 

ഡ�രും വിലോസവു
�ങ്ങിയ �ട്ടിക  Address.ods എന്ന ഫയലോയും 

തയ്യോറോക്കിയിട്ടുV്. �ടെ6ടുഡക്കVവരുടെ� ഡ�രും വിലോസവും 
ോതൃകയിഡലക്ക് 

ഒടെന്നോന്നോയി ഉള്‍ടെപ്പടുത്തി ടെവഡzടെറ ക്ഷണക്കത്തുകള്‍ തയ്യോറോക്കണം. 

ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ ഇതി�് പ്രഡയോജ�ടെപ്പടുന്ന സഡ6തം ഏതോണ്?

➢ Clone Formatting

➢ Style

➢ Mail Merge

➢ Indexes and Tables

17. ലിബര്‍ഓഫീസ്  റൈററ്ററിടെല വിവിധ  റൈസ്റ്റലുകള്‍  തിരടെഞ്ഞടുക്കുന്നതിനുള്ള 

Styles  ജോലത്തിടെന്റ ഒരു ഭോഗ
ോണ്  �ിത്രത്തില്‍  കോണുന്നത് .  ചുവന്ന 

വൃത്തത്തില്‍ അ�യോളടെപ്പടുത്തിയ റൈസ്റ്റല്‍ ഏത് ?

➢ Character Styles

➢ Frame Styles

➢ Page Styles

➢ Paragraph Styles

18. ഗീത, ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഡപ്രോജക്ട് റിഡപ്പോര്‍ട്ടിടെന്റ      

ശീര്‍ഷകങ്ങള്‍ക്ക് �ല്‍കോ�ോയി ഒരു പുതിയ റൈസ്റ്റല്‍                              
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�ിര്‍മ്മിക്കോനുഡ�ശിക്കുന്നു. തോടെRക്കോണുന്നതുഡ�ോടെല രV് ടെസറ്റ് ഡഫോര്‍


ോറ്റുകള്‍ ഇതി�ോയി തയ്യോറോക്കിയിട്ടുV്.

സെസറ്റ്  1: അക്ഷര വലുപ്പം : 13, അക്ഷര ഫോ
ിലി :  ര��,  അക്ഷര 

�ിറം : ചുവപ്പ്

സെസറ്റ് 2:  
ോര്‍ജി�ില്‍ �ിന്നുള്ള അകലം : 18, ടെ�ക് സ്റ്റ്                

അറൈലന്‍ടെ
ന്റ് : ഇ�ത്

ഒരു തലടെക്കട്ടിടെ� സംബന്ധിച്ച്,  ഈ  ടെസറ്റുകളില്‍ ഏതു�ഡയോഗിച്ചോണ്  

ഡഫോര്‍
ോറ്റ് ടെ�യ്യുവോന്‍ സോധിക്കുക?

➢ രണ്ടു‍ടെസറ്റുകളും‍ഉപലേയോഗിക്കോം‍

➢ ആദ്യ ടെസറ്റ് 
ോത്രഡ
 തലടെക്കട്ടി�് ഡയോജിക്കുകയുള്ളു

➢ രVോ
ടെത്ത ടെസറ്റ് 
ോത്രഡ
 തലടെക്കട്ടി�് ഡയോജിക്കുകയുള്ളു

➢ രണ്ടു ടെസറ്റുകളും ഡയോജിച്ചവയല്ല

19. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒരു ഡ
ോക്യുടെ
ന്റിടെല 

ഉള്ള�ക്കപ്പട്ടികടെയ സംബന്ധിക്കുന്ന �ില പ്രസ്തോവ�കള്‍ ചുവടെ� ഡ�ര്‍ക്കുന്നു. 

പ്രസ്താവന 1: ഡ
ോക്യുടെ
ന്റിടെന്റ വിവിധ ശീര്‍ഷകങ്ങളുള്‍ടെപ്പടുന്ന 

ഡ�ജുകളിഡലക്ക് എളുപ്പത്തില്‍ എത്തോന്‍ സോധിക്കുന്നു.

പ്രസ്താവന 2:ഡ
ോക്യുടെ
ന്റിടെല ഉള്ള�ക്കടെത്ത കുറിച്ചുള്ള ടെ�ോതുവോയ ധോരണ 

എളുപ്പത്തില്‍ ലഭിക്കുന്നു.

ഇവയില്‍ ശരിയോയത് ഏത്?

➢ രണ്ടും‍ശരിയോണ്.

➢ രണ്ടും ടെതറ്റോണ്.
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➢ ഒന്നോ
ത്ത പ്രസ്തോവ� ശരിയോണ്. രVോ
ടെത്ത പ്രസ്തോവ�  ടെതറ്റോണ്.

➢ ഒന്നോ
ടെത്ത പ്രസ്തോവ� ടെതറ്റോണ്.രVോ
ടെത്ത പ്രസ്തോവ� ശരിയോണ്.

20. ഡകരളടെത്തക്കുറിച്ചുള്ള ഒരു ഡ
ോക്യുടെ
ന്റി�് തയ്യോറോക്കിയ ഉള്ള�ക്കപ്പട്ടികയുടെ� 

ഒരു ഭോഗ
ോണ് �ിത്രത്തില്‍ കോണുന്നത്. ഇതില്‍ തലടെക്കട്ടി�് (Index)  

സോധോരണ ഗതിയില്‍ എന്തു റൈസ്റ്റലോയിരിക്കും ഉVോയിരിക്കുക ?

➢ Contents Heading

➢ Figure Index Heading

➢ Heading 1

➢ Header 1
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CLASS 10    I C T   CHAPTER 4 
               PYTHON GRAPHICS

 തിയറി ച�ോച	
ോത്തരങ്ങൾ    ഭോഗം  :  1

1.  

മുകളില്‍ കകോടുത്ത ച�ോഗ്രോം റണ്‍ ക�യ്തച�ോൾ ഒരു ച�ററ്ക!ന്റിക# കതറ്റ് കോരണം 

invalid syntax എന്ന സച)ശ!ോണ് വന്നത്. ശരിയോയ നിര്‍ച.ശം എന്തോണ് ?

A from turtle import* B for i in range(6) 

C forward(100): D left(60):

Correct Answer:  A from turtle import*

2. പൈ1ത്തണ്‍ ഗ്രോഫിക് സ് ച�ോഗ്രോമുകളുക4 ഔട്ട്പുട്ട് #ഭിക്കുന്നത്  എവിക4?

A പൈ1ത്തണ്‍ ക9ല്ലില്‍          B IDLE ജോ#കത്തില്‍

C പൈ1ത്തണ്‍ ഗ്രോഫിക് സ് ജോ#കത്തില്‍ D ബ്രൗസറില്‍

Correct Answer: C പൈ1ത്തണ്‍ ഗ്രോഫിക് സ് ജോ#കത്തില്‍

3. നീ#നിറത്തില്‍ സ!�തുരം വരച്ച് ചുവന്ന നിറം നിറക്കുവോന്‍ സജു ഒരു ച�ോഗ്രോം 

തയ്യോറോക്കി. എന്നോല്‍ അതില്‍ color("red") എന്നവരി കതറ്റോകണന്ന് 

അധ
ോ1കന്‍ അവചനോടു 1റഞ്ഞു. എന്തോണ് ശരിയോയ നിര്‍ച.ശം ?   



A color("blue") B color("red", "blue")

C color(red,blue) D color("blue","red")

Correct Answer: D color(“blue”, “red”)

4.

ഈ പൈ1ത്തണ്‍ ച�ോഗ്രോം �വര്‍ത്തി�ിച്ചോല്‍ #ഭിക്കുന്ന രൂ1ം എന്തോണ് ?

A 600 അളവുള്ള ചകോണ്‍ B 1000 അളവുള്ള ചകോണ്‍

C ത്രിചകോണം D �തുരം

Correct Answer: A 600 അളവുള്ള ചകോണ്‍

5. സ!�തുരം നിര്‍മ്മിക്കോനോയി രോജി തയ്യോറോക്കിയ ഈ പൈ1ത്തണ്‍ ച�ോഗ്രോം 

�വര്‍ത്തി�ിച്ചച�ോൾ സ!�തുരം #ഭിച്ചില്ല . ച�ോഗ്രോ!ിക# ഏതു നിര്‍ച	ശ!ോണ് 

രോജിക്ക് കതറ്റിയത്.?   
A  from turtle import*

B for i in range(4):

C forward(100) D right(60)  
                            



Correct Answer: D right(60)

6. തോകP കകോടുത്തിട്ടുള്ളവയില്‍ ഏതോണ്  പൈ1ത്തണ്‍ ച�ോഗ്രോ!ിങ്ങില്‍ 4ര്‍ട്ടില്‍ 
ഗ്രോഫികസ് �വര്‍ത്തനക്ഷ!!ോക്കുന്നതിന് നല്‍ചകണ്ട നിര്‍ച.ശം?

A clear() B begin_fill()

C from turtle import* D forward()

Correct Answer: C from turtle import*
 
7.  ഈ ച�ോഗ്രോ!ികന്റ ഔട്ട്പുട്ടില്‍ എത്ര വൃത്തങ്ങൾ ഉണ്ടോയിരിക്കും?

             A.  20 B. 10
1.   
2.              C. 4 D. 3
3.

   Correct  Answer: D. 3

8. പൈ1ത്തണ്‍ ച�ോഗ്രോം ഉ1ചയോഗിച്ച് 1ോചറ്റണ്‍ നിര്‍മ്മിക്കുചVോൾ 1ോചറ്റണിക# വരകൾക്ക് 
നീ# നിറം #ഭിക്കോന്‍ ഏത് നിര്‍ച.ശം നല്‍കണം?

  A color(blue) B color blue

C color("blue") D color "blue"

  Correct Answer: C color("blue")



9. അനു തയ്യോറോക്കിയ ഈ പൈ1ത്തണ്‍ ച�ോഗ്രോം �വര്‍ത്തി�ിച്ചച�ോൾ #ഭിച്ച 
ഔട്ട്പുട്ട് എന്തോയിരിക്കും?.

        A സ!�തുരം B ത്രിചകോണം

         C സ!1ഞ്ചഭുജം D സ!9ഡ്ഭുജം

 
   

Correct Answer:    C  സ!1ഞ്ചഭുജം

10.  ഒരു  സ!ഭുജ  ത്രിചകോണം  നിര്‍മ്മിക്കുന്നതിനുള്ള  പൈ1ത്തണ്‍  ച�ോഗ്രോ!ോണ്
നല്കിയിരിക്കുന്നത്. ചുവക4  തന്നിട്ടുള്ളതില്‍ നിന്ന് ഏത് നിര്‍ച.ശം ഉ1ചയോഗിച്ചോ#ോണ്
ത്രിചകോണത്തികന്റ വരകളുക4 വീതി നിര്‍ണ്ണയിക്കോന്‍ കPിയുക.?

         A pencolor() A pencolor()

          
       C            pen_thickness() D penline()

   Correct Answer: B pensize()

11. ഈ ച�ോഗ്രോ!ികന്റ ഔട്ട്പുട്ടോയി #ഭിക്കുന്ന  രൂ1ത്തിന് എത്രയൂനിറ്റ് നീളമുള്ള വശം 

ഉണ്ടോയിരിക്കും?

 A 144 യൂനിറ്റ്     B  100 യൂനിറ്റ്      C 100 യൂനിറ്റ്     D 6 യൂനിറ്റ്

 Correct Answer:     B   100 യൂനിറ്റ് നീളമുള്ള വശം ഉണ്ടോയിരിക്കും



12.

   
 മുകളില്‍ നല്‍കിയിരിക്കുന്ന ച�ോഗ്രോ!ില്‍ നോ#ോ!കത്ത വരിയില്‍ എന്തു !ോറ്റം വരുത്തിയോല്‍ 
സ!9ഡ്ഭുജം #ഭിക്കും? 

  A right(90) B right(120)

  C left(60) D left(90)

  Correct Answer: C left(60)

13.  പൈ1ത്തണ്‍  ഗ്രോഫിക്സ്  ച�ോഗ്രോ!ില്‍  ചുവന്ന  നിറത്തില്‍  രൂ1ം  വരയ്കുകയും  ,
വരച്ചതിനുചശ9ം  നീ#  നിറം  നിറയ് ക്കുകയും  ക�യ്യോന്‍  തോകP  കകോടുത്ത  
ഏത് നിര്‍ച	ശ!ോണ് സ്വീകരിചക്കണ്ടത് ?

  A. pencolor("blue","red") B. pencolor("red","blue")

 C. color("red","blue") d. color("blue","red")

  Correct Answer: c. color(“red”,”blue”)

14.  ഒരു പൈ1ത്തണ്‍ ച�ോഗ്രോ!ില്‍ ആവര്‍ത്തന നിര്‍ച.ശത്തിനകത്ത് വീണ്ടും ആവര്‍
ത്തിച്ചു വചരണ്ട നിര്‍ച.ശങ്ങൾ ഏതു ച1രി#ോണ് അറിയക�ടുന്നത് ?

  A ലൂ�് B      പൈവല്‍ ലൂ�്    C ചഫോര്‍ ലൂ�്      D കന�ഡ് ലൂ�്

   Correct Answer:  D കന�ഡ് ലൂ�്



   

15.  പൈ1ത്തണ്‍ ഗ്രോഫിക്സ് ച�ോഗ്രോമുകളില്‍, രൂ1ങ്ങളില്‍ നിറം നിറക്കുന്നതിനുചവണ്ടി

ഉ1ചയോഗിക്കുന്ന  begin_fill()  എന്ന നിര്‍ച.ശചത്തോ4് ച�ര്‍ന്നു നല്‍ചകണ്ട നിര്‍ച.ശം

എന്ത് ?

  A pencolor() B end_fill() C stop_fill() D start_fill()

     Correct Answer:  B end_fill()

16. ഈ ച�ോഗ്രോ!ില്‍  for k in range(4): എന്ന നിര്‍ച	ശം എന്തിനുള്ളതോണ് ?
                                                                              

    A നോ#് �തുരങ്ങൾ വരക്കോന്‍
    B നോ#് യൂണിറ്റ് നീളമുള്ള വര വരക്കോന്‍
    C നോ#് തവണ ആവര്‍ത്തിക്കോന്‍
     D നോ#് വൃത്തങ്ങൾ വരക്കോന്‍

   Correct Answer:  C നോ#് തവണ ആവര്‍ത്തിക്കോന്‍

17. തന്നിരിക്കുന്ന ച�ോഗ്രോം �വര്‍ത്തി�ിച്ചോല്‍ #ഭിക്കുന്ന രൂ1ത്തില്‍ എത്ര വൃത്ത 
ങ്ങൾ ഉണ്ടോയിരിക്കും ?

   A 50 B 6 C 60 D 10

  Correct Answer:  .B 6

18. പൈ1ത്തണ്‍ ഗ്രോഫിക് ജോ#കത്തില്‍  കതളിയുന്ന വരകൾക്ക് നീ#നിറം നല്‍
കോനുള്ള നിര്‍ച.ശം ചുവക4 നല്‍കിയവയില്‍ ഏത്?

A clr("blue") B linecolor("blue")



C pencolour(blue) D pencolor("blue")

  Correct Answer: D pencolor("blue")

19. ചുവക4 കകോടുത്തിട്ടുള്ളവയില്‍ ഏതോണ്  ഒരു കV്യൂട്ടര്‍ ഭോ9 ?

  A ജിചയോജിബ്ര B സണ്‍ചiോക്ക് 

 C ഇങ്ക്സ് ചക1് D പൈ1ത്തണ്‍

 Correct Answer : D പൈ1ത്തണ്‍

20. പൈ1ത്തണ്‍ ഗ്രോഫിക്സ് ജോ#കത്തിക# വരകളും എഴുത്തുകളും പൂര്‍ണ്ണ!ോയി 
ഇല്ലോതോക്കുവോന്‍ ഉ1ചയോഗിക്കുന്ന നിര്‍ച.ശം എന്ത് ?

 A clearscreen () B clear()

  C clrscr() D clearall ()

   

  Correct Answer: B clear()



STANDARD X – ICT – UNIT 5: നെ�റ്റ് വര്‍ക്കിങ്  - ച�ോച��ോത്തരങ്ങള്‍

1.  ലാബിലെല ഒരു കമ്പ്യൂട്ടറില്‍ സേ�വ് ലെ�യ്തിട്ടുള്ള ഫയലിലെ�  അസേ� ലാബിലെല മലെ�ാരു 
കമ്പ്യൂട്ടറുമായി പങ്കുലെവക്കുവാന്‍ �ാലെ% ലെകാടുത്തവയില്‍ ഏ�് �ൗകര്യമാണ് 
പ്രസേയാജ�ലെ/ടുത്തുക?  

➢ നെ�റ്റ് വര്‍ക്കിങ് 

➢ ഡാ�ാസേബ�് 

➢ പ്രിന്റര്‍

➢ DBMS

2. ചുവലെ; �ന്നിരിക്കുന്നവയില്‍ ലെ�� ് വര്‍ക്ക് ഹബ്ബി�് പകരമായി ഉപസേയാഗിക്കാവുന്ന 
ഉപകരണം ഏ�് ?

➢ സേകബിള്‍

➢  കണക ്;ര്‍

➢  സ്വിച്ച്

➢ പ്രിന്റര്‍

3. കമ്പ്യൂട്ടറുകലെF ലെ��് വര്‍ക്ക്  ലെ�യ്യാന്‍ ഉപസേയാഗിക്കുന്ന  UTP സേകബിFില്‍ എത്ര 
സേജാഡി വയറുകളുണ്ട്?

➢ 4

➢ 12

➢ 8

➢ 10

4.  കമ്പ്യൂട്ടറില്‍ വിവരങ്ങള്‍ ലെപ്രാ��്  ലെ�യ്യുന്നതും  സൂക്ഷിക്കുന്നതും  ചുവലെ; 
ലെകാടുത്തിരിക്കുന്ന ഏ�് രൂപത്തിലാണ് ?

➢ ഡിജിറ്റല്‍

➢ അ�സേലാഗ്

➢ ഇന്‍ഫ്രാലെറഡ് �രംഗം

➢ RF �രംഗം
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5. ലെ;ലിസേഫാണ്‍ ശൃംഖലലെയ സേമാഡവുമായി  ബന്ധി/ിക്കുന്ന�ി�ായി  സേകബിFില്‍  
ഉപസേയാഗിക്കുന്ന കണക ്;റിലെന്റ സേപലെരന്താണ് ?

➢ �്വിച്ച്

➢ RJ 45 

➢ RJ 11

➢ ഹബ്

6. ഒരു ലെ��് വര്‍ക്കിലുള്ള കമ്പ്യൂട്ടറുകള്‍ �മ്മിലുള്ള വിവര കൈകമാ�ം 
�ിയന്ത്രിക്കുന്ന�ിനുള്ള ഉപകരണം ചുവലെ; �ല്‍കിയ�ില്‍ �ിന്നും കലെണ്ടത്തുക.

➢ പ്രിന്റര്‍

➢ സ്കാ�ര്‍

➢  ഹബ് / സ്വിച്ച്

➢ ലെവബ് കാമറ

7. ലെ��് വര്‍ക്കിലുള്‍ലെ/ട്ടിരിക്കുന്ന കമ്പ്യൂട്ടറുകള്‍ക്ക്  ഐ .  പി.  അഡ്രസ്സ്  �ല്‍കുന്ന�്
�ാലെ% ലെകാടുത്തിരിക്കുന്ന ഏ�് സേപ്രാസേട്ടാസേകാള്‍ അനു�രിച്ചാണ് ?

➢ TCP/IP

➢ POP

➢ SMB

➢ SSH

8. ഡിജി�ല്‍ �ിഗ്നലുകലെF അ�സേലാഗായും �ിരിച്ചും മാറ്റുവാന്‍ ക%ിവുള്ള ഉപകരണം 
ചുവലെ; ലെകാടുത്തവയില്‍ �ിന്ന് കലെണ്ടത്തുക.

➢ ച*ോഡം

➢ RJ 45 

➢ RJ 11

➢ ഹബ്

9. ലെ;ലിസേഫാണ്‍ ശൃംഖലയിലൂലെ; ഇന്റര്‍ലെ��് �ൗകര്യം ലഭ്യമാകുന്ന�ി�്

അ�്യാവശ്യമായ ഉപകരണം ചുവലെ; �ല്‍കിയവയില്‍ �ിന്നും കലെണ്ടത്തുക.

https://t.me/Shenibloggroup


➢ പ്രിന്റര്‍

➢ ച*ോഡം 

➢ സ്കാ�ര്‍

➢ ലെവബ് ക്യാമറ

10. ലെ��് വര്‍ക്കിലുള്‍ലെ/ട്ടിരിക്കുന്ന ഉപകരണങ്ങളുലെ; �ാമകരണത്തിലും വിവരങ്ങള്‍ 
വി�ിമയം ലെ�യ്യുന്ന�ിനും മറ്റും പാലിസേക്കണ്ട ലെപാതു �ിയമങ്ങള്‍ 
ഏതുസേപരിലറിയലെ/ടുന്നു?

➢ ലെ��് മാ�്ക്

➢ ഐ. പി. അ ഡ്രസ്സ്

➢ ലെmയറിംഗ് 

➢ നെ�റ്റ് വര്‍ക്ക് ച,ോച-ോചക്കോളുകള്‍

11. ഒരു ലെകട്ടി;ത്തിനുള്ളിലെലസേയാ ഒരു മുറിക്കുള്ളിലെലസേയാ കമ്പ്യൂട്ടറുകലെF പരസ്പരം 
ബന്ധി/ിക്കുന്ന �ംവിധാ�ം ചുവലെ; ലെകാടുത്തിട്ടുള്ളവയില്‍ ഏ�ാണ് ? 

➢ WAN

➢ LAN

➢ PAN

➢ MAN

12 .�ന്നിരിക്കുന്നവയില്‍ IPv4 സേപ്രാസേട്ടാസേക്കാള്‍ പ്രകാരമുള്ള ഐ. പി. അഡ്രസ്സാകുവാന്‍ 
�ാധ്യ�യില്ലാത്ത�് ഏ�് ?

➢ 192.168.200.10

➢ 192.192.192.192

➢ 192.168.256.10

➢ 192.168.222.10

13. വയര്‍ലെലസ്സ്  ലെ�റ്റുവര്‍ക്കുകFില്‍ കമ്പ്യൂട്ടറുകള്‍ പരസ്പരം  ബന്ധി/ിക്കുന്ന�്  ചുവലെ; 
ലെകാടുത്തിട്ടുള്ള ഏ�് ഉപകരണം / �സേr�ം ആണ് ഉപസേയാഗിക്കുന്ന�് ?

➢ UTP സേകബിള്‍
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➢ ആര്‍.എഫ് തരംഗങ്ങള്‍

➢ ഹബ്

➢ �്വിച്ച് 

14. �ാലെ% ലെകാടുത്തവയില്‍ കമ്പ്യൂട്ടറുകലെF  ലെ��് വര്‍ക്ക്  ലെ�യ്യുന്ന�ി�്
ആവശ്യമില്ലാത്ത ഉപകരണം ഏ�ാണ് ?

➢ പരസ്പരം ബന്ധി/ിക്കുന്ന UTP സേകബിള്‍ 

➢ ഡിജിറ്റല്‍ സിഗ്നലിനെ� അ�ചലോഗോയും തിരിച്ചും *ോറ്റോന്‍ കഴിവുള്ള ഉപകരണം

➢ വിവരകൈകമാ�ം �ിയന്ത്രിക്കുന്ന ഉപകരണം

➢ UTP സേകബിFിലെ� കമ്പ്യൂട്ടറുമായി ബന്ധി/ിക്കുന്ന കണക്ടര്‍

15. വിവരങ്ങള്‍ പരസ്പരം കൈകമാറത്തക്ക വിധത്തില്‍ കമ്പ്യൂട്ടറുകലെF ബന്ധി/ിക്കുന്ന 

�ംവിധാ�ത്തിലെന്റ സേപലെരന്ത് ? 

➢ കമ്പ്യൂ-ര്‍ നെ�റ്റ് വര്‍ക്കിങ് 

➢ സേyാഗ്

➢ ഫയല്‍�ിസ്റ്റം

➢ ഓ/സേറ�ിങ് �ിസ്റ്റം

16. �ന്നിരിക്കുന്നവയില്‍ IPv4 സേപ്രാസേട്ടാസേക്കാള്‍ പ്രകാരമുള്ള ഐ. പി. അഡ്രസ്സാകുവാന്‍ 

�ാധ്യ�യുള്ള�് ഏ�് ?

➢ 192.168.200.256

➢ 92.168.256.10

➢ 192.168.256.200

➢ 192.168.222.10

17. കമ്പ്യൂട്ടറുകള്‍ ലെ��് വര്‍ക്ക് ലെ�യ്യുന്ന�ിലെന്റ ഭാഗമായി UTP സേകബിളുകള്‍ ചുവലെ; 

ലെകാടുത്തിരിക്കുന്ന ഏ�് കണക്ടര്‍ ഉപസേയാഗിച്ചാണ് കമ്പ്യൂട്ടറുകളുമായി 

ബന്ധി/ിക്കാറുള്ള�് ?
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➢ RJ 11

➢ ഹബ്

➢ �്വിച്ച്

➢ RJ 45

➢ 18. ചുവലെ; ലെകാടുത്തിരിക്കുന്ന ഏ�് ഉപകരണലെത്ത സേമാഡവുമായി 

ബന്ധി/ിക്കുന്ന�ി�ാണ് �ാധാരണയായി RJ 11 കണക്ടര്‍  ഉപസേയാഗിക്കുന്ന�്? 

➢ പ്രിന്റര്‍

➢  �്വിച്ച്

➢ കംമ്പ്യൂട്ടര്‍

➢ നെCലിചഫോണ്‍

19.  കമ്പ്യൂട്ടറുകള്‍ ലെ��് വര്‍ക്കിസേലക്ക് പ്രസേവശിക്കുസേമ്പാള്‍ �്വസേമധയാ (Automatic) Automatic) ) 

ഐ.പി വിലാ�ം ലഭ്യമാകുന്ന �സേr�ം ഏ�് ?

➢ SSH

➢ SMB

➢ DHCP

➢ POP

20. ഒരു രാജ്യം മുഴുവന്‍ വ്യാപിച്ചുകി;ക്കുന്ന കമ്പ്യൂട്ടറുകലെF പരസ്പരം ബന്ധി/ിക്കുന്ന 

ലെ��് വര്‍ക്കി�് പറയുന്ന സേപലെരന്താണ് ? 

➢ WAN

➢ LAN

➢ MAN

➢ RAM
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   പത്താം ക്ലാസ്  ഐ ക്ലാസ്  ഐ ഐ.സി.ടി
അധ്യായം ക്ലാസ്  ഐ 9:ചലിക്കും ക്ലാസ്  ഐ ചിത്രങ്ങള്‍

ചചാച�്യാത്തരങ്ങള്‍

1) ചുവടെട തന്നിരിക്കുന്നവയില്‍ അനിച ഷന്‍ നിര്‍മ്മാണത്തിന്  ഐ ഉപചയാഗിക്കാവുന്ന  

സ്വതന്ത്ര ചസാഫ്റ്റ്  ഐ ടെവയര്‍ ഏത്  ഐ?

a) Tupi: Open 2D magic

b) Anime studio

c) Sunclock

d) Inkscape

2) Synfig Studio യിടെല  ടൂള്‍ച/ാക്സിലുള്ള ഈ സൂചനാചിത്രം ക്ലാസ്  ഐ ഏത്  ഐ ടൂളിടെന സൂചിപ്പിക്കുന്നു ?

a) Layers Panel

b) Time Track Panel

c) Parameters Panel

d) Canvas

3) Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിടെ9 തനതു ഫയല്‍ചഫാര്‍ ാറ്റ്  ഐ ഏത്  ഐ?   

a) svg

b) flv

c) sifz

d) xcf

4) Inkscape ല്‍ തയാറാക്കിയ svg ചിത്രം ക്ലാസ്  ഐ Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിചലക്ക്  ഐ  ഉള്‍

ടെപ്പടുത്താന്‍ ചുവടെട നല്‍കിയിരിക്കുന്ന ഏത്  ഐ സച?തം ക്ലാസ്  ഐ ഉപചയാഗിക്കാം ക്ലാസ്  ഐ?

a) ഇന്‍ചസര്‍ട്ട്  ഐ

b) ഓപ്പണ്‍

c) ഇംപ�ോര്‍ട്ട്
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d) ടെറന്‍ഡര്‍

5) Synfig Studio യില്‍ തയാറാക്കുന്ന ഒരു അനിച ഷടെന, flv ഫയലാക്കി  ാറ്റാന്‍ ചുവടെട

നല്‍കിയവയില്‍ ഏത്  ഐ സച?ത ാണ്  ഐ ഉപചയാഗിചക്കണ്ടത്  ഐ?

a) Save

b) Revert

c) Import 

d) Render 

6) സിന്‍ഫിഗ്  ഐ സ്റ്റുഡിചയായില്‍ രണ്ട്  ഐ നിറങ്ങള്‍ ലയിച്ചുള്ള പശ്ചാത്തലം ക്ലാസ്  ഐ നല്‍കാന്‍ ഏറ്റവും ക്ലാസ്  ഐ 

അനുചയാജ്യ ായ ടൂള്‍ ഏതാണ്  ഐ.

a) Gradient Tool

b) Fill Tool

c) Scale Tool

d) Rectangle Tool

7) Synfig Studio യില്‍നിന്ന്  ഐ എക്സ്  ഐ ചപാര്‍ട്ട്  ഐ ടെചയ്യാന്‍ സാധിക്കുന്ന വീഡിചയാ ഫയല്‍

ചഫാര്‍ ാറ്റ്  ഐ ചുവടെട നല്‍കിയവയില്‍ ഏത്  ഐ?

a) Gif

b) png

c) mpeg

d) xcf

8) ചുവടെട തന്നിരിക്കുന്നവയില്‍ �്വി ാന അനിച ഷന്‍ തയാറാക്കുന്നതിന്  ഐ  

ഉപചയാഗിക്കാവുന്ന  സ്വതന്ത്ര ചസാഫ്റ്റ്  ഐ ടെവയര്‍ ഏത്  ഐ?

a) Adobe flash

b) Synfig Studio

c) ToonBoom

d)  Blender

9)  Synfig Studio യിടെല ചില ടൂളുകളും ക്ലാസ്  ഐ അവയുടെട വിവരണങ്ങളും ക്ലാസ്  ഐ ആണ്  ഐ  പട്ടികയില്‍ 

നല്‍കിയിരിക്കുന്നത്  ഐ.വിട്ട്  ഐചപായ ഭാഗം ക്ലാസ്  ഐ ചുവടെട ടെകാടുത്തിയിരിക്കുന്നതില്‍ നിന്ന്  ഐ 
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കടെണ്ടത്തുക.

a) Fill Tool

b) Transform Tool

c) Scale Tool

d) Rotate Tool

10) png ചഫാര്‍ ാറ്റിലുള്ള ചിത്രങ്ങള്‍SynfigStudio ചസാഫ്  ഐ റ്റ്  ഐ ടെവയറിചലക്ക്  ഐ ഉള്‍ടെപ്പടുത്താന്‍

 ചുവടെട നല്‍കിയിരിക്കുന്ന ഏത്  ഐ  ാര്‍ഗം ക്ലാസ്  ഐ ഉപചയാഗിക്കാം ക്ലാസ്  ഐ?

a) File --> Open

b) File --> Import

c) Insert --> Image

d) Insert --> bitmap 

11) Synfig  Studio  ഉപചയാഗിച്ച്  ഐ  പ്രഭാതസൂര്യടെ9 അനിച ഷന്‍ തയാറാക്കുകയാണ്  ഐ  

വരുണ്‍.  സൂര്യന്  ഐ  അതിടെ9 സഞ്ചാരത്തിനനുസരിച്ച്  ഐ  വ്യത്യസ്ത നിറം ക്ലാസ്  ഐ  നല്‍കുന്നതിന്  ഐ  

ഉപചയാഗിചക്കണ്ട ടൂള്‍ ഏതാണ്  ഐ? 

a) Gradient Tool

b) SmoothMove Tool

c) Fill Tool

d) Rectangle Tool

12) Synfig Studio യില്‍ അനിച ഷന്‍ തയാറാക്കുചgാള്‍, ഒ/്  ഐ ജക്  ഐ ടുകളുടെട സ്ഥാനം ക്ലാസ്  ഐ 

ക്ര ീകരിക്കുന്നതില്‍ ശ്രദ്ധിചക്കണ്ട കാര്യം ക്ലാസ്  ഐ ചുവടെട നല്‍കിയ വയില്‍ ഏതാണ്  ഐ?

a) ചലനം ക്ലാസ്  ഐ ആരം ക്ലാസ്  ഐഭിക്കുന്ന ടെnയി ിലും ക്ലാസ്  ഐ അവസാനിക്കുന്ന ടെnയി ിലും ക്ലാസ്  ഐ  ഒ/്  ഐ ജക്  ഐ ട്  ഐ Hide 

ടെചയ്യുക.  

b) ചലനം ക്ലാസ്  ഐ ആരം ക്ലാസ്  ഐഭിക്കുന്ന  ടെnയി ില്‍ ഒ/്  ഐ ജക്  ഐ ട്  ഐ Hide ടെചയ്യുക.  

c) ചലനം ആരംഭിക്കുന്ന ഫ്രെ�യിമിലും അവസോനിക്കുന്ന ഫ്രെ�യിമിലും ഒബ് ജക് ടിഫ്രെ  സ്ഥോനം 

വ്യത്യോസഫ്രെ$ടുത്തുക.

d) ചലനം ക്ലാസ്  ഐ ആരം ക്ലാസ്  ഐഭിക്കുന്ന ടെnയി ിലും ക്ലാസ്  ഐ അവസാനിക്കുന്ന ടെnയി ിലും ക്ലാസ്  ഐ ഒ/്  ഐ ജക്  ഐ ട്  ഐ ഒചര 
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സ്ഥാനത്ത്  ഐ ക്ര ീകരിക്കുക

13) Synfig Studio യില്‍ പശ്ചാത്തലത്തിന്  ഐ നല്‍കിയ ചpഡിയ9്  ഐ നിറം ക്ലാസ്  ഐ എഡിറ്റ്  ഐ ടെചയ്യാന്‍

എവിടെടയാണ്  ഐ സൗകര്യമുള്ളത്  ഐ? 

a) ടെലചയഴ്  ഐ സ്  ഐ പാനല്‍

b) ടൈടം ക്ലാസ്  ഐട്രാക്ക്  ഐ പാനല്‍

c) �രോമീപ(ഴ് സ് �ോനല്‍

d) കാന്‍വാസ്  ഐ ചപ്രാപര്‍ട്ടീസ്  ഐ

14) Synfig Studio യില്‍ Frames Per Second  ാറ്റുന്നതിന്  ഐ ഏത്  ഐ ജാലകത്തിലാണ്  ഐ 

സൗകര്യമുള്ളത്  ഐ?

a) ടെലചയഴ്  ഐ സ്  ഐ പാനല്‍

b) ടൈടം ക്ലാസ്  ഐട്രാക്ക്  ഐ പാനല്‍

c) പരാ ീചറ്റഴ്  ഐ സ്  ഐ പാനല്‍

d) കോന്‍വോസ് പ,ോ�ര്‍ട്ടീസ്

15) Synfig Studio യില്‍ കീടെnയിമുകള്‍ നിശ്ചയിച്ചാല്‍ അവയ്ക്കിടയിടെല ടെnയിമുകടെള 

ചസാഫ്റ്റ്  ഐ ടെവയര്‍ സ്വയം ക്ലാസ്  ഐ പൂര്‍ത്തിയാക്കുന്ന സച?തത്തിന്  ഐ പറയുന്ന ചപടെരന്ത്  ഐ ?

a) ടെറന്‍ഡറിങ്  ഐ

b) ട്വീനിങ്

c) ഇന്‍ചസര്‍ട്ടിങ്  ഐ

d) എക്സ്  ഐചപാര്‍ട്ടിങ്  ഐ

16) Synfig Studio യില്‍ തയാറാക്കിയ അനിച ഷന്‍ Export ടെചയ്യാവുന്ന ചലച്ചിത്ര    
ചഫാര്‍ ാറ്റ്  ഐ ചുവടെട നല്‍കിയവയില്‍ ഏത്  ഐ ?

a) jpg

b) svg

c) png
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d) flv

17)  ചറാ/ര്‍ട്ട്  ഐ  /ി  ക്വാറ്റ്  ഐ ല്‍/ാം ക്ലാസ്  ഐ  നിര്‍മ്മിച്ച ഒരു സ്വതന്ത്രചസാഫ്റ്റ്  ഐ ടെവയര്‍ ചുവടെട നല്‍

കിയിരിക്കുന്നവയില്‍ ഏതാണ ്  ഐ?

a) ക്യൂജിസ്  ഐ

b) സിന്‍ഫിഗ് സ്റ്റുഡിപയോ 

c) ഇ?്  ഐസ്  ഐ ചകപ്  ഐ

d) ജിചയാജിബ്ര

18)  ചലചിത്രങ്ങളു ായി /ന്ധടെപ്പട്ട ഒരു ചുരുക്കചപ്പരാണ്  ഐ FPS.                                   

ഇത്  ഐ എന്തിടെന സൂചിപ്പിക്കുന്നു ?

a) ഒരു  ിനിറ്റില്‍ പ്ര�ര്‍ശിപ്പിക്കുന്ന സീനുകളുടെട എണ്ണം ക്ലാസ്  ഐ.

b) ഒരു ടെസക്ക9ില്‍ പ്ര�ര്‍ശിപ്പിക്കുന്ന കഥാപാത്രങ്ങളുടെട എണ്ണം ക്ലാസ്  ഐ.

c) ഒരു ഫ്രെസക്ക ില്‍ ,ദര്‍ശി$ിക്കുന്ന ഫ്രെ�യിമുകളുഫ്രെട എണ്ണം.

d) ഒരു  ിനിറ്റില്‍ പ്ര�ര്‍ശിപ്പിക്കുന്ന ടെnയിമുകളുടെട എണ്ണം ക്ലാസ്  ഐ.

19) Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറില്‍ ആകാശത്തിടെല നക്ഷത്രങ്ങടെള വരയ്ക്കുകയാണ്  ഐ ചരഷ്  ഐ  . 

വരച്ച നക്ഷത്രങ്ങടെള ആകാശത്തിടെ9 വിവിധ ഭാഗങ്ങളില്‍ വിന്യസിക്കുന്നതിനായി 

ഉപചയാഗിചക്കണ്ട ടൂള്‍ ഏതാണ്  ഐ?

a) Gradient Tool

b) Star Tool

c) Transform Tool  

d)  Fill Tool

20)  Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിടെല ഒരു ടൂളിടെ9 ചിത്ര ാണ്  ഐ നല്‍കിയിരിക്കുന്നത്  ഐ  
ഇതിടെ9 ഉപചയാഗടെ ന്ത്  ഐ?

a) ചതുരാകൃതിയിലുള്ള ഒ/്  ഐ ജക്റ്റ്  ഐ ഉണ്ടാക്കാന്‍

b) വൃത്താകൃതിയിലുള്ള ഒ/്  ഐ ജക്റ്റ്  ഐ ഉണ്ടാക്കാന്‍
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c) ഒബ് ജക്റ്റുകള്‍ ഫ്രെസലക്റ്റ് ഫ്രെചയ്യോന്‍ 

d) രചണ്ടാ അതിലധികച ാ വര്‍ണങ്ങള്‍ ലയിപ്പിക്കാന്‍

21) Synfig Studio യില്‍ ചലനം ക്ലാസ്  ഐ ആരം ക്ലാസ്  ഐഭിക്കുന്ന ടെnയി ിചനയും ക്ലാസ്  ഐ ചലനം ക്ലാസ്  ഐ അവസാനിക്കുന്ന 

ടെnയി ിചനയും ക്ലാസ്  ഐ ടെപാതുവായി പറയുന്ന ചപടെരന്ത്  ഐ ?

a) Tween Frames

b) Key Frames 

c) In between Frames

d) Frames Per Second

22) ചുവടെട നല്‍കിയിരിക്കുന്ന പ്രസ്താവനകളില്‍ നിന്നും ക്ലാസ്  ഐ Synfig Studio 

ചസാഫ്റ്റ്  ഐ ടെവയറിടെനക്കുറിച്ചുള്ള ശരിയായത്  ഐ തിരടെ�ടുക്കുക.

a) ത്രി ാന അനിച ഷന്‍ ചസാഫ്റ്റ്  ഐ ടെവയറാണ്  ഐ .

b) വിര്‍ച്വല്‍ ച�ാ/്  ഐ ചസാഫ്റ്റ്  ഐ ടെവയറാണ്  ഐ.

c) ഓഡിചയാ റിചക്കാര്‍ഡിങ്  ഐ ചസാഫ്റ്റ്  ഐ ടെവയറാണ്  ഐ.

d) ദ്വിമോന അനിപമഷന്‍ പസോഫ്റ്റ് ഫ്രെവയറോണ് . 

23) സിന്‍ഫിഗ്  ഐ സ്റ്റുഡിചയാ ചപാലുള്ള ചസാഫ്  ഐ റ്റ്  ഐ ടെവയറുകളില്‍ അനിച ഷന്‍ നിര്‍മ്മാണം ക്ലാസ്  ഐ 

എളുപ്പത്തിലാക്കാന്‍  ഉപചയാഗിക്കുന്ന Tweening സച?തം ക്ലാസ്  ഐ ഏത്  ഐ ഗണിത 

 സച?തത്തിടെ9 സഹായത്താലാണ്  ഐ സാധ്യ ാകുന്നത്  ഐ?

a) Squaring

• Interpolation

b) Maximizing

c) Factorization

24) Synfig Studio യില്‍ അനിച ഷന്‍ നിര്‍മ്മിക്കുചgാള്‍ Animate Editing Mode 

പ്രവര്‍ത്തനക്ഷ  ാചക്കണ്ടതിടെ9 അനിവാര്യ ായ ഘട്ടം ക്ലാസ്  ഐ ചുവടെട നല്‍കിയവയില്‍ 

ഏതാണ്  ഐ? 

a) അനിച ഷന്‍ പ്രവര്‍ത്തിപ്പിക്കുചgാള്‍
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b) കീടെnയിമുകള്‍ ഉള്‍ടെപ്പടുത്തുചgാള്‍

c) കീഫ്രെ�യിമുകളില്‍ ഒബ് ജക ് ടിഫ്രെ  സ്ഥോനം വ്യത്യോസഫ്രെ$ടുത്തുപDോള്‍  

d) അനിച ഷന്‍ എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്യുചgാള്‍

25) Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിടെല ഒരു ടൂളിടെ9 ചിത്ര ാണ്  ഐ നല്‍കിയിരിക്കുന്നത്  ഐ       

ഇതിടെ9 ഉപചയാഗടെ ന്ത്  ഐ?

a) ചതുരാകൃതിയിലുള്ള ഒ/്  ഐ ജക്റ്റ്  ഐ ഉണ്ടാക്കാന്‍

b) വൃത്തോകൃതിയിലുള്ള ഒബ് ജക്റ്റ് ഉണ്ടോക്കോന്‍

c) ചതുരാകൃതിയില്‍ ഒ/്  ഐ ജക്റ്റുകള്‍ ടെസലക്റ്റ്  ഐ ടെചയ്യാന്‍

d) രചണ്ടാ അതിലധികച ാ വര്‍ണങ്ങള്‍ ലയിപ്പിക്കാന്‍

SHORT ANSWER TYPE QUESTIONS

1) Synfig Studio ചസാഫ്  ഐ റ്റ്  ഐ ടെവയറിടെല ടൂള്‍ ച/ാക്സിലുള്ള രണ്ട്  ഐ ടൂളുകള്‍ ചുവടെട 
ടെകാടുത്തിരിക്കുന്നവയില്‍ നിന്നും ക്ലാസ്  ഐ തിരടെ�ടുക്കുക.

a) Star Tool

b) Transform Tool

c) Circle Tool

d) Smooth Move Tool

e) Gradient Tool

2)     ചുവടെട നല്‍കിയതില്‍ നിന്ന്  ഐ സ്വതന്ത്ര �്വി ാന അനിച ഷന്‍ ചസാഫ്റ്റ്  ഐ ടെവയറുകള്‍ 
തിരടെ�ടുക്കുക.

a) Toon Boon

b) Anime studio

c) Tupi: Open 2D Magic

d) Synfig Studio

e) Adobe Flash

3) Synfig Studio ടൂള്‍ ച/ാക്സിലുള്ള രണ്ട്  ഐ ടൂളുകള്‍ ചുവടെട ടെകാടുത്തവയില്‍ നിന്നും ക്ലാസ്  ഐ 
തിരടെ�ടുക്കുക.
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a) Star Tool

b) Edit paths by nodes

c) Draw bezier curves and straight lines

d) Gradient Tool

e) Draw calligraphic or strokes

4) അനിച ഷനു ായി /ന്ധമുള്ള ശരിയായ രണ്ട്  ഐ പ്രസ്താവനകള്‍ ടെതരടെ�ടുക്കുക.

a) Tupi: Open 2D Magic  ഒരു ദ്വിമോന അനിപമഷന്‍ പസോഫ്റ്റ് ഫ്രെവയറോണ്.

b) തുടര്‍ച്ചയോയും പവഗത്തിലും നിശ്ചലചിത്രങ്ങള്‍ ചലി$ിക്കുപDോഴോണ് 

അനിപമഷന്‍ നിര്‍മ്മിക്കഫ്രെ$ടുന്നത്.

c) Import ടെചയ്ത നിശ്ചല ചിത്രങ്ങള്‍ ടെകാണ്ട്  ഐ അനിച ഷന്‍ സാധിക്കില്ല. 

d) അനിച ഷന്‍ ടെചയ്യുചgാള്‍ ചലനചവഗത നിയന്ത്രിക്കാന്‍ സം ക്ലാസ്  ഐവിധാന ില്ല.

e) FPS അനിച ഷന്‍ ടെചയ്യുചgാള്‍ അപ്രസക്ത ാണ്  ഐ.

5) ചുവടെട നല്‍കിയിരിക്കുന്നവയില്‍ നിന്നും ക്ലാസ്  ഐ  Synfig Studio 

ചസാഫ്റ്റ്  ഐ ടെവയറിടെനക്കുറിച്ച്  ഐ ശരിയായ രണ്ട്  ഐ പ്രസ്താവനകള്‍ കടെണ്ടത്തുക.

a) ഇത്  ഐ ഒരു ഭൂവിവരവ്യവസ്ഥാ ചസാഫ്  ഐ റ്റ്  ഐ ടെവയറാണ്  ഐ.

b) ഇത്  ഐ ഒരു സ്വതന്ത്ര ത്രി ാനഅനിച ഷന്‍ ചസാഫ്റ്റ്  ഐ ടെവയറാണ്  ഐ.

c) ഇത് ഒരു സ്വതന്ത്ര ദ്വിമോന അനിപമഷന്‍ പസോഫ്റ്റ് ഫ്രെവയറോണ്.

d) പറോബര്‍ട്ട് ബി. ക്വോ(്ല്‍ബോം ആണ് ഇത് നിര്‍മിച്ചത്.

e) ടിം ക്ലാസ്  ഐ ച/ര്‍ചണഴ്  ഐ സ്  ഐ ലി  ആണ്  ഐ ഇത്  ഐ നിര്‍ ിച്ചത്  ഐ.

6) നക്ഷത്രങ്ങളുടെട ചലനം ക്ലാസ്  ഐ തയാറാക്കാന്‍ Synfig Studio ല്‍  വരച്ച ഒരു ചിത്ര ാണ്  ഐ 
മുകളിലുള്ളത്  ഐ . ചുവടെട നല്‍കിയിരിക്കുന്ന ഏടെതല്ലാം ക്ലാസ്  ഐ ടൂളുകളാണ്  ഐ ഇതിന്  ഐ  
ഉപചയാഗിച്ചിട്ടുണ്ടാവുക ?  

a) Circle Tool

b) Fill Tool

c) Text Tool

d) Star Tool
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e) Rectangle Tool

7)  Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിടെനക്കുറിച്ച്  ഐ ചുവടെട നല്‍കിയിട്ടുള്ള പ്രസ്താവനകളില്‍ 
 നിന്ന്  ഐ ശരിയായ രണ്ട്  ഐ പ്രസ്താവനകള്‍ തിരടെ�ടുക്കുക

a) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിപമഷന്‍ ഫ്രെ,ോജക് ട് ഫയലോയി പസവ് ഫ്രെചയ്യോം.

b) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിച ഷന്‍ ടെപ്രാജക്  ഐ ട്  ഐ ചിത്ര ഫയലായി  ാത്രച  
ചസവ്  ഐ ടെചയ്യാന്‍ സാധിക്കൂ.

c) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിപമഷന്‍ ഫ്രെ,ോജക് ട് വീഡിപയോ ഫയലോയി 
എക്സ്പ�ോര്‍ട്ട് ഫ്രെചയ്യോം

d) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിച ഷന്‍ ടെപ്രാജക്  ഐ ട്  ഐ വീഡിചയാ ഫയലായി 
എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്യാന്‍ സാധിക്കില്ല.

e) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിച ഷന്‍ ടെപ്രാജക്  ഐ ട്  ഐ gif ഫയലായി  ാത്രച  
ചസവ്  ഐ ടെചയ്യാന്‍ സാധിക്കൂ.

8) Synfig Studio ഉപചയാഗിച്ച്  ഐ തയാക്കിയ രണ്ട്  ഐ തരം ക്ലാസ്  ഐ ഫയലുകളാണ്  ഐ  birds.sifz,

 birds.flv എന്നിവ. ഇതു ായി /ന്ധടെപ്പട്ട ശരിയായ രണ്ട്  ഐ പ്രസ്താവനകള്‍ താടെഴ 
ടെകാടുത്തിരിക്കുന്നവയില്‍ നിന്നും ക്ലാസ്  ഐ കടെണ്ടത്തുക

a) Synfig Studio പസോഫ് (് ഫ്രെവ യറു�പയോഗിച്ച്  തയ്യോറോക്കിയ ഫ്രെ,ോജക് ട് ഫയലോണ്  

birds.sifz

b) pdf ആയി എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്തതാണ്  ഐ  birds.sifz

c) വീഡിചയാ ഫയലായി എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്തതാണ്  ഐ birds.sifz

d) വീഡിചയാ ഫയലായി എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്തതാണ്  ഐ birds.flv

e) Synfig Studio പസോഫ് (് ഫ്രെവ യറു�ഫ്രെയഗിച്ച്  തയ്യോറോക്കിയ ഫ്രെ,ോജക് ട് ഫയലോണ്  

birds.flv

9) Synfig Studio ല്‍ ടെലയറുകടെള സം ക്ലാസ്  ഐ/ന്ധിച്ച്  ഐ ചുവടെട നല്‍കിയിരിക്കുന്നവയില്‍ 

 നിന്ന്  ഐ ശരിയായ പ്രസ്താവനകള്‍ തിരടെ�ടുക്കുക. 

a) ടെലയറുകള്‍ പ്ര�ര്‍ശിപ്പിക്കുന്നത്  ഐ ടൈടം ക്ലാസ്  ഐട്രാക്  ഐ പാനലിലാണ്  ഐ .

b) പാനലിലുള്ള ടെലയറുകളുടെട ക്ര ം ക്ലാസ്  ഐ  ാറ്റാന്‍ സാധിക്കില്ല .

c) പുതിയ ടെലയറുകള്‍ നിര്‍ ിക്കാന്‍ സാധിക്കില്ല .
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d) �ോനലിലുള്ള ഫ്രെലയറുകളുഫ്രെട ക്രമം മോ(ോന്‍ സോധിക്കും .

e) �ോനലിലുള്ള ഫ്രെലയറുകഫ്രെള ആവശ്യോനുസരണം ഗ്രൂ$് ഫ്രെചയ്യോന്‍ സോധിക്കും .

10) Synfig Studio യിടെല Layer ടെന സം ക്ലാസ്  ഐ/ന്ധിച്ച ശരിയായ രണ്ട്  ഐ 
പ്രസ്താവനകള്‍ ചുവടെട നല്‍കിയവയില്‍ നിന്നും ക്ലാസ്  ഐ തിരടെ�ടുക്കുക.?

a) ഉള്‍ഫ്രെ$ടുത്തുന്ന എല്ലോ  Object കളും വ്യത്യസ്ത ഫ്രെലയറുകളില്‍ ആയിരിക്കും.

b) ഉള്‍ടെപ്പടുത്തുന്ന എല്ലാ  Object കളും ക്ലാസ്  ഐ ഒരു ടെലയറില്‍ തടെന്ന ആയിരിക്കും ക്ലാസ്  ഐ.

c) ഒരു Object ഫ്രെന ഒഴിവോക്കുപDോള്‍ ആ ഒബ് ജക് ട് ഉള്‍ഫ്രെ$ടുന്ന  ഫ്രെലയര്‍ മോത്രം 

നഷ്ടഫ്രെ$ടുന്നു.

d) ഏടെത?ിലും ക്ലാസ്  ഐ ഒരു  Object ടെന ഒഴിവാക്കുചgാള്‍ എല്ലാ ടെലയറുകളും ക്ലാസ്  ഐ നഷ്ടടെപ്പടുന്നു.

e) Preview കാണുചgാള്‍ ഒരു ടെലയര്‍  ാത്രച  ദൃശ്യ ാവൂ.
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STANDARD 10

CHAPTER : 10 കമ്പ്യൂട്ടറിന്റെ� പ്രവര്‍ത്തകസംവിധാനം

1) കമ്പ്യൂട്ടറിന്റെ� പിതാവ് എന്നറിയന്റെ'ടുന്നതാര് ?

A അഡ ബൈ.റണ്‍

B ചാള്‍സ് .ാബേ.ജ്

C ന്റെകന്‍ ബേതാംസണ്‍

D ന്റെഡന്നീസ് റിച്ചി

2) ചാള്‍സ് .ാബേ.ജ് രൂപകല്പന ന്റെചയ്ത അനലിറ്റിക് എഞ്ചിന്റെന ആദ്യ കമ്പ്യൂട്ടര്‍ എന്ന് 
വിളിക്കാന്‍ കാരണന്റെEന്ത് ?

A ആധുനിക കമ്പ്യൂട്ടറിന്റെ� ഘടനയുEായി സാE്യമുള്ളതിനാല്‍
B ആധുനിക കമ്പ്യൂട്ടറിന്റെ� രൂപവുEായിസാE്യമുള്ളതിനാല്‍
C ആധുനിക കമ്പ്യൂട്ടറിന്റെ� അടിസ്ഥാനാശയങ്ങള്‍ ഇതിനുബേവണ്ടിയും വിഭാവനം

ന്റെചയ്യന്റെ'ട്ടതിനാല്‍
D ആധുനിക കമ്പ്യൂട്ടറിന്റെ� ഓപബേററ്റിങ്ങ് സിസ്റ്റവും ബേപ്രാഗ്രാമുകളും ഉള്ളതിനാല്‍

3) റിച്ചാര്‍ഡ് സ്റ്റാള്‍Eാന്‍ ബേനതൃത്വം ന്റെകാടുത്ത ഗ്നു (GNU) ബേപ്രാജക്റ്റ് ഒരു ഓ'ബേററ്റിങ് സിസ്റ്റം നിര്‍
Eിക്കാനാരംഭിച്ചബേ'ാള്‍ താന്റെg ന്റെകാടുത്തിരിക്കുന്നവയില്‍ ഏതിന്റെനയാണ് Eാതൃകയാക്കിയത്  

A Linux  B Unix  C BSD D Debian

4) ഗ്നു /ലിനക്സ് ഓപബേററ്റിങ് സിസ്റ്റം പ്രവര്‍ത്തിക്കുന്ന കമ്പ്യൂട്ടറുകളില്‍ ഫയലുകള്‍ താല്‍
ക്കാലികEായി സൂക്ഷിക്കുന്നതിനായി തയ്യാറാക്കുന്ന ഒരു അതിബേവഗ ഫയല്‍ സിസ്റ്റം ഏതാണ്
?

A റൂട്ട്  (/)

B ബേ|ാം (/home)

C സ്വാപ്   (swap)  
D റാം (RAM)

C സ്വാപ് (swap)

5) ഗ് നു /ലിനക്സിന്റെന സം.ന്ധിച്ച് താന്റെg പറയുന്നവയില്‍ ഏറ്റവും ശരിയായ പ്രസ്താവന 
ഏതാണ് ?



A ഇത് ഒരു സ്വതന്ത്ര ഓപബേററ്റിങ്ങ് സിസ്റ്റEാണ്  .  

B ഇത് പൂര്‍ണEായും ലിനസ് ബേടാര്‍വാള്‍ഡ്സ് നിര്‍Eിച്ചതാണ്.

C ഇതിന്റെ� പ്രധാന ഭാഗങ്ങന്റെളല്ലാം റിച്ചാര്‍ഡ് സ്റ്റാള്‍Eാന്‍ നിര്‍Eിച്ചതാണ്.

D ഇതിന്റെ� പ്രധാന ഭാഗങ്ങന്റെളല്ലാം ന്റെഡന്നീസ് റിച്ചി നിര്‍Eിച്ചതാണ്.

6) ഗ് നു / ലിനക് സ് ഓ'ബേററ്റിങ് സിസ്റ്റത്തിന്റെ� ബേകര്‍ണല്‍ ബേപ്രാഗ്രാം ഏതാണ് ?

A ഗ് നു

B ലിനക് സ്

C യുനിക്സ്

D റൂട്ട് (/)

7)  കമ്പ്യൂട്ടറിന്റെ� |ാര്‍ഡ് ന്റെവയറുEായി ബേനരിബേട്ടാ ബൈ�വറുകളുന്റെട സ|ായബേത്താന്റെടബേയാ 

സംവദിക്കുന്ന ഓ'ബേററ്റിങ് സിസ്റ്റത്തിന്റെ� ഭാഗത്തിന്റെന വിളിക്കുന്ന ബേപന്റെരന്താണ് ?

A ന്റെ�ല്‍

B കEാ�് 

C ബേകര്‍ണല്‍

D GUI

8)ചുവന്റെട നല്‍കിയിട്ടുള്ളവയില്‍ സമ്പൂര്‍ണEായ ഓ'ബേററ്റിങ് സിസ്റ്റം അല്ലാത്തതേ��ാണ് ?

A യൂനിക്സ് (Unix)

B BSD (Berkeley Software Distribution)

C Eാക് ഓഎസ്  X (Mac OS X)

D ഗ് നു ന്റെ|ര്‍ഡ്   (GNU HURD)   

9) താന്റെg പറയുന്നവരില്‍ ആരാണ് യുനിക്സ് എന്ന ഓപബേററ്റിങ് സിസ്റ്റത്തിന്റെ� നിര്‍Eാണത്തില്‍ 
പങ്കാളിയായിരുന്നത് ?

A ന്റെഡന്നീസ് റിച്ചിയും ന്റെകന്‍ ബേതാംസണും

B ന്റെകന്‍ ബേതാംസണും റിച്ചാര്‍ഡ് സ്റ്റാള്‍Eാനും

C റിച്ചാര്‍ഡ് സ്റ്റാള്‍Eാനും ന്റെഡന്നീസ് റിച്ചിയും

D ന്റെകന്‍ ബേതാംസണ്‍, ന്റെഡന്നീസ് റിച്ചി,

റിച്ചാര്‍ഡ് സ്റ്റാള്‍Eാന്‍ എന്നിവര്‍



10) ഇന്ന് കാണുന്ന പല ഓ'ബേററ്റിങ് സിസ്റ്റങ്ങളും ചുവന്റെട നല്‍കിയിട്ടുള്ള ഒരു ഓ'ബേററ്റിങ് 
സിസ്റ്റത്തില്‍ നിന്ന് വികസി'ിന്റെച്ചടുത്തവബേയാ അല്ലങ്കില്‍ അതിന്റെന Eാതൃകയാക്കി 
പുനഃസൃഷ്ടിച്ചവബേയാ ആണ്. ഏതാണ് ആ ഓ'ബേററ്റിങ് സിസ്റ്റം ?

A വിന്‍ബേഡാസ്

B Eാക് ഓഎസ്  X

C യുനിക്സ്

D BSD

11) കമ്പ്യൂട്ടറിന്റെല ഏത് |ാര്‍ഡ് ന്റെവയര്‍ ഘടകവും പ്രവര്‍ത്തിക്കണന്റെEങ്കില്‍ അത് എങ്ങന്റെന 

പ്രവര്‍ത്ത ിക്കണം എന്ന് നിര്‍ബേ¦ശിക്കുന്ന ഒരു  ബേപ്രാഗ്രാം കൂന്റെടയുണ്ടാകണം. ഈ ബേപ്രാഗ്രാEിന്റെന  

താന്റെg പറയുന്നവയില്‍ ഏതു ബേപരിലാണ് വിളിക്കുന്നത് ?

A ബൈ�വര്‍

B ന്റെടര്‍Eിനല്‍

C ബേകര്‍ണല്‍

D ന്റെ�ല്‍

12) |ാര്‍ഡ് ഡിസ്കിന്റെന പല ബേ«ാക്കുകളായി തിരിച്ച് ഫയല്‍ സിസ്റ്റം നിര്‍Eിക്കുന്ന പ്രക്രിയ 
ചുവന്റെട നല്‍കിയവയില്‍ ഏത് ബേപരില്‍ അറിയന്റെ'ടുന്നു ?

A കEാ�ിങ്

B ഇന്‍സ്റ്റബേല�ന്‍

C എഡിറ്റിങ്

D ബേഫാര്‍Eാറ്റിങ്

13) ഓബേരാ ഓ'ബേററ്റിങ് സിസ്റ്റവും അതിനു ബേയാജിച്ച രീതിയില്‍ |ാര്‍ഡ് ഡിസ്കിന്റെന ബേഫാര്‍Eാറ്റ് 
ന്റെചയ്തിരിക്കുന്നതിന്റെന അതാതിന്റെ� …………………….എന്നു വിളിക്കുന്നു. വിട്ടുബേപായ ഭാഗത്തിന് 
അനുബേയാജ്യEായവ ചുവന്റെട നിന്ന് തിരന്റെ¯ടുക്കുക.

A ന്റെ�ല്‍

B ഫയല്‍ സിസ്റ്റം 

C കEാ�് 

D ബേകര്‍ണല്‍

14) NTFS എന്ന ഫയല്‍ സിസ്റ്റം ചുവന്റെട നല്‍കിയിട്ടുള്ള ഏത് ഓ'ബേററ്റിങ് 
സിസ്റ്റത്തിനാണ് ഏറ്റവും അനുബേയാജ്യEായത് ?



A ഗ് നു / ലിനക്സ്

B ബൈEബേക്രാബേസാഫ്റ്റ് വിന്‍ബേഡാസ്

C ആ'ിള്‍ Eാക് ഓഎസ്  X

D യുനിക് സ്

15) താന്റെg പറയുന്നവയില്‍ ഒരു സ്മാര്‍ട്ട് ബേഫാണ്‍ ഓപബേററ്റിങ്ങ് സിസ്റ്റം ലിനക്സ്
അടിസ്ഥാനEാക്കി തയ്യാറാക്കിയിട്ടുള്ളതാണ്. അത് ഏതാണ് ?

A ആന്‍ബേ�ായ്ഡ്

B «ാക്ക്ന്റെ.റി 10

C iOS

D Symbian

16) ഒരു കമ്പ്യൂട്ടറിന്റെ� |ാര്‍ഡ് ഡിസ്ക് പാര്‍ട്ടീ�ന്റെനക്കുറിച്ചുള്ള വിവരങ്ങള്‍ കന്റെണ്ടത്തുന്നതിന് 

ഉപബേയാഗിക്കാവുന്ന ബേസാഫ്റ്റ് ന്റെവയര്‍ ചുവന്റെട ന്റെകാടുത്തിട്ടുള്ളവയില്‍ ഏതാണ് ?

A Gnu Hurd

B Disks (gnome-disks)

C KompoZer

D MySQL

B Disks (gnome-disks)

17) ചുവന്റെട ന്റെകാടുത്തിട്ടുള്ളതില്‍ ഏത് ഓ'ബേററ്റിങ് സിസ്റ്റEാണ് XNU എന്ന ബേകര്‍ണല്‍ 

ഉപബേയാഗിക്കുന്നത് ?

A ഗ് നു / ലിനക്സ്

B വിന്‍ബേഡാസ്  NT

C ആ'ിള്‍ Eാക്    OS X  

D  BSD

18)  കുത്തകാവകാശ ബേസാഫ്റ്റ് ന്റെവയറുകന്റെള സം.ന്ധിച്ച് ചുവന്റെട ന്റെകാടുത്തിട്ടുള്ള 

പ്രസ്താവനകളില്‍  ഏതാണ് സാധാരണഗതിയില്‍ ശരിയാവുക  ?

A ഉപബേയാക്താവിന് സൗജന്യEായി ലഭ്യEാക്കും.

B ഉപബേയാക്താവിന് ബേസാg് സ് ബേകാഡ് ലഭ്യEാക്കും.

C ഉപബേയാക്താവിന് ഒ.് ജക് ട് ബേകാഡ് Eാത്രം ലഭ്യEാക്കും  .  

D ഉപബേയാക്താവിന് ബേസാg് സ് ബേകാഡും ഒ.് ജക്ട് ബേകാഡും ലഭ്യEാക്കും.



19) സ്വതന്ത്ര ബേസാഫ്റ്റ് ന്റെവയറുകന്റെള സം.ന്ധിച്ച് ചുവന്റെട ന്റെകാടുത്തിരിക്കുന്നവയില്‍ 

അനുബേയാജ്യEായ പ്രസ് താവന ഏത് ?

A ഉപബേയാക്താവിന് ബേസാg് സ് ബേകാഡ് Eാത്രം ലഭ്യEാക്കും

B ഉപബേയാക്താവിന് ഒ.് ജക് ട് ബേകാഡ് Eാത്രം ലഭ്യEാക്കും.

C ഉപബേയാക്താവിന് ബേസാg് സ്  ബേകാഡും ഒ.് ജക് ട് ബേകാഡും ലഭ്യEാക്കും

D ഉപബേയാക്താവിന് ബേസാg് സ്  ബേകാഡും ഒ.് ജക് ട് ബേകാഡും ലഭ്യEാക്കില്ല.

20) താന്റെg പറയുന്നവയില്‍ ഏതാണ് വിയറ.്ള്‍ ഡിബൈവസുകള്‍ക്ക് (Wearable Devices) 

ഉദാ|രണEല്ലാത്തത് ?

A സ് Eാര്‍ട്ട് വാച്ചുകള്‍

B ശരീരത്തിനകത്ത് ഘടി'ിച്ച ഇന്‍സുലിന്‍

പമ്പുകള്‍

C കാEറയും ന്റെസന്‍സറുമുള്ള ബേലാക്കറ്റുകള്‍

D ന്റെEാബൈ.ല്‍ ബേഫാണുകള്‍
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